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Give your Word tables some
breathing room and increase
their readability

Protect your network from
spam with Microsoft’s
Intelligent Message Fi

Enhance site capabilities with
servier-side scripting

From the Editor

Word tables aren’t always easy to
work with, and you want to ensure that
the text in your tables are legible. We'll
show you two ways to add some space to
your table to avoid overcrowded text.

Spam can ruin your day when you're
maintaining a Microsoft Exchange
Server 2003. Here's how you can
squash spam with a server-side solution
instead of relying solely on third-party
applications.

Finally, we'll give you another tool
for your web design arsenal: PHP. Using
PHP, you can create websites through
server-side scripting and learn an
alternative to HTML.
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Putting your training into practice.

Give your Word tables some breathing room
and increase their readability

Tables (usually) don't have long and winding sentences to navigate, superfluous accoutrements

to contend with, or text and paragraph formats to interpret. Instead, a well-designed table

includes concise, clear text. But when you must include more text in a table, you must include
white space to keep the cells from overcrowding each other. Fortunately, there are a couple of
simple ways to add padding to your cells and breathe a little fresh air back into your tables.

w

Method 1: Update cell margins

The most straightforward way to add more
empty space to your table is to increase the
margins for your table’s cells. By default, each
cellin a table has 0.08-inch right and left
margins, and nonexistent (0-inch) top and
bottom margins.

To change the margins for your entire

table:

1. Click anywhere within the table and
then choose Table | Table Properties
from the menu bar.

2. Click on the Table tab in the Table
Properties dialog box, and then click
the Options button to launch the Table
Options dialog box.

Boost the values in the Top, Bottom,
Left, and Right spin boxes in the

Default Cell Margins panel, and click
OK twice to close both dialog boxes.

Cell margins

Related Courses
- Word 2007 — Level 1

. Word 2007 — Level 2

. Word 2007 — Level 3

Add padding to selected cells only
You can also increase the white space for

one or more selected cells, while leaving the
default settings in place for the remaining cells.

To change an individual cell’s margins:

1. Select the cell(s) you want to change.
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2. Choose Table | Table Properties
from the menu bar.

3. Click on the Cell tab, and then click
the Options button.

4. Inthe Cell Options dialog box,
deselect the Same As The Whole
Table check box.

5. Update the Top, Bottom, Left, and

Right settings, as shown in Figure A.

6. Click OK twice to close both dialog
boxes.

Adapt for Word 2007
When you click in a table in Word
2007, the Table Tools ribbon displays
with two tabs: Design and Layout. To
change your table’s margins, go to
the Layout tab, and in the Alignment
group, click the Cell Margins button.
The Table Options dialog box displays
and you can adjust your margins. To
change an individual cell’s margins,
access the Table Properties dialog box
by selecting the Table Tools ribbon'’s
Layout tab, and in the Table group,
click the Properties button. Then you
can follow the same steps you would
in earlier versions.

Change your table’s para-
graph spacing on the Home tab.
In the Paragraph group, click the
Line Spacing button and choose an
option from the dropdown list — or
select Line Spacing Options to open
the dialog box.

Method 2: Increase
paragraph spacing
Another easy way to add more white space

to a table’s cells is to adjust the paragraph
spacing of the text within the cells.

To add space at the top or bottom of
a cell:

1. Select the first or last line in the cell
(as applicable), or select all of the
text to simultaneously add space
to the top and bottom of the cell.
Alternatively, select a series of cells
you want to edit, or choose Table |
Select Table to update every cell.

2. Choose Format | Paragraph from
the menu bar and click on the
Indents And Spacing tab in the
Paragraph dialog box.

3. Enter the amount of space you
want to add in the Before and/or
After text boxes in the Spacing
panel, as shown in Figure B.

4, C(lick OKto close the dialog box
and return to your document.

You can also update the amount of white

space on either side of the text in your
selected cells in the Paragraph dialog
box. To do so, simply enter the amount
of space you want to add in the Left
and/or Right text boxes (as
applicable) in the Indentation
panel. When you've finished,
click OK.
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with unexpected results, as
illustrated in Figure C.

Adjust the indentation and spacing around cell
contents to add padding to your cells.

Default Spacing

There are two simple attributes you
can adjust to add white space to
vour table:

® Paragraph Spacing

o  Cell Margins

Adjusted Paragraph Spacing

Adjusted Cell Margins

There are two simnple
attributes you can adjust to
add white space to your table:

- Paragraph Spacing
- Cell Margins

There are two simple
attributes vou can adjust to
add white space to your table:
® Paragraph Spacing
o Cell Margins

C It isn’t difficult to distinguish the difference between these techniques on some cells.




INFORMATION SYSTEMS PROTECTION

Protect your network from spam with
Microsoft’s Intelligent Message Filter

Unwanted commercial email (called UCE, junk mail, or spam) has become one of the biggest problems facing Related Courses
corporate networks. Many rejoiced when the U.S. Congress passed the CAN SPAM act in 2003, but like other . 2400 Implementing and Managing Microsoft
legislative efforts to address the problem, it has had little practical effect. For every spammer who's been Exchange Server 2003

convicted and sentenced, thousands of others continue to flood our mailboxes with hundreds of thousands
of unwanted messages. Rather than wait for the government to solve the problem, it's up to companies and
individuals to take advantage of technological solutions.
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EXChange and IMF «  Sender filtering How IMF works words, rather than just relying on criteria
With older versions of Exchange, you +  Recipient filtering The Intelligent Message Filter f.OV. ::Ait V;’°U|d flag amessage ashspam, y
had to rely on third-party spam-filtering . Connection filtering Exchanges so called b?c?use tis able indi o recognlzes'cr||ter'|:? that v;cr:u
software, but with Exchange Server 2003,  These filters are applied when an SMTP to "leam” the characteristics of spam incicate 2 mfeSSfage ' tegitimate. . .IS
messages that distinguish them from reduces the incidence of false positives.

you have many spam-fighting options. server tries to send the messages to your

It's still a good idea to deploy a server- Exchange server. legitimate email messages. In other

level anti-spam solution, such as:

«  Sunbelt Software’s IHateSpam for Cisco Awards
Exchange s \ Mew Horizons
- GFI MailEssentials Business skills for the new world of work Learning Partner

In business today, productivity is key to your success. Whether that means setting up of the Year
projects for success, forecasting and analyzing trends, or managing critical business
information, it is vital that you have the skills to work at peak performance. You already {USF’CEHEE]E}

« Extensible Messaging Platform
(EMP) Enterprise Anti-Spam

Now, however, Microsoft provides free know how to use Microsoft® Office System applications. New Horizons offers Microsoft
anti-spam technologies that you can use Business Skills Series Courses to teach you how to use those applications to more effi- stfuan]is
alone or in conjunction with third-party ciently manage, work with, and prioritize information to make better decisions. Go to CISCO.
anti-spam software. www.NewHorizons.com for information on courses that cover topics such as: PARTNER
® 4003 Summarizing Microsoft Office Excel 2003 Data to Make Better Business

. Decisions
EXChange ﬁltermg features ®© 4006 Time and Task Management Using Microsoft Office Outlook 2003
Exchange 2003 includes three anti-spam ® 4008 Building Better Microsoft Office Word 2003 Documents In Less Time

features “out of the box.” These are: \_ ) F Read More About It
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IMF is applied after the SMTP
session, so messages that are filtered
by the built-in Exchange filters have
already been handled.

Note: Microsoft’s spam-filtering
technologies can comprise a multi-
layered filtering strategy. Mail first goes
through the Exchange filters during the
SMTP session, then through IMF after
the SMTP session. If spam messages get
through both and make it to the client
computer, Outlook 2003 has junk mail
filters to catch them.

Deploying IMF

IMF was originally released as a
standalone add-on for Exchange 2003,
but now it’s included with Exchange 2003
Service Pack 2, which you can download
at www.microsoft.com/downloads/
details.aspx?familyid=535BEF85-
3096-45F8-AA43-60F1F58B3C40&
displaylang=en.

SP2 is approximately 110 MB
and contains version 2 of IMF along
with other new features and fixes for
Exchange.

Where to install IMF

You should install IMF on Exchange
servers that function as gateway servers
(those that accept incoming email from
the internet) and enable it on all SMTP

virtual servers that accept internet
messages.

What if you have non-Exchange
email servers at the internet edge?
Then, you should install IMF on your
Exchange bridgehead servers that get
the mail from the non-Exchange gate-
way servers and enable it on SMTP vir-
tual servers on the bridgehead server.

Note: Special considerations apply if
you're deploying IMP in a cross-forest
environment. Then, you'll need to enable
cross-forest authentication.

Installation procedure

The IMF wizard, which is shown in
Figure A, walks you through the steps
of selecting the IMF components you
want to install. You need to be a local
administrator and a member of the
Exchange Administrators group to run
the wizard.

You can select to install the IMF
itself and/or the IMF management
tools. The IMF can only be installed on
an Exchange server. You can install the
management tools on a workstation
to manage IMF remotely, but you must
install the Exchange System Manager
on the workstation first.

Configure and
customize IMF

You configure IMF settings via the
Intelligent Message Filtering tab in the
Message Delivery Properties dialog box,

as shown in Figure B.

You can set thresholds based on
each message’s Spam Confidence Level

is spam. Ratings range from 0 to 9.
Messages rated above the threshold
setting will be blocked. You can set IMF
to archive blocked messages.

You can configure IMF at two
levels:

o The gateway

The mailbox store

(SCL) rating. The higher the SCL rating,
the more likely it is that the message

i‘é‘n Microsoft Exchange Intelligent Message Filter Installation x|

—

Welcome to the Microsoft Exchange
Intelligent Message Filter Installation Wizard

Thiz wizard will guide you through the steps of installing Microzoft Exchange
Intelligent tMezsage Filter.

For the latest information about the ingtallation and configuration of Microzoft
Exchange Inteligent Mezzage Filker, go to
hittp: A dvan, microzoft, comdexchangedimf.

It iz recommended that you download the Microsoft Exchange Intelligent
Meszage Filter Deplogment Guide fram this website prior bo installing the
product and that pou download and inztall the most recent updates to
Inteligent Mezsage Filker,

Updated werziong of the Inteligent Mezsage Filker are available on this
webzibe on a regular bazis,

WARMNIMG: Thiz computer progran iz pratected by copyright law and
international treaties. Unauthorized duplication or distribution of this program,
ar any partian of it may result in severe civil ar ciminal penalties, and will be
prozecuted ta the masimum estent possible under the law,

To continue, click Next.

< Back | Cancel |
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components.

The IMF wizard guides you through the steps of installing and selecting
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Enable IMF on virtual SMTP
servers
The next step is to enable IMF on virtual
SMTP servers that receive mail from the
internet. You do this via the Exchange
System Manager.

Follow these steps:

1. In the left pane of the Exchange
System Manager console, expand
Servers, the name of the server,
Protocols, and then SMTP.

2. Right-click on IMF and select
Properties.

3. Click on the General tab.

4, Below Apply Intelligent Message
Filtering To The Following Virtual
Servers’ IP Addresses, select the
check box for the SMTP virtual
server(s) on which you want to
enable IMF.

5. Click OK.

Configure the archive location
It's best to set IMF to archive the
messages it blocks, so you can check
them to be sure legitimate messages
haven't been caught in the filters.

By default, when you select to
archive blocked messages, they're
stored in X:\Program Files \ Exchsrvr
\ mailroot \ vsi <SMTP virtual server
number>\ UCEArchive, where X rep-
resents the letter of the partition on
which Exchange is installed.

You can change the location for
storing the archived messages by edit-
ing the registry.

Follow these steps:

1. Open the registry editor
(regedit.exe).

2. Inthe left pane, navigate to the
following key:
HKEY_LOCAL_MACHINE\
Software\Microsoft\Exchange\
ContentFilter.

3. Intheright pane, right-click on
ContentFilter and select New, and
then String Value.

Name the new value ArchiveDir.

v

Right-click on the new ArchiveDir
value and select Modify.

6. Inthe Value Data field, enter the
path of the file location where you
want to archive blocked messages.

Authenticated
connections

By default, messages that are sent by
authenticated users don't go through
IMF. This usually works fine, since your
authenticated users can usually be
trusted not to send spam. However, there
might be cases where you want IMF to
filter messages that are sent through
authenticated connections and assign
SCL ratings to them. Here's how:

1. Open the registry editor
(regedit.exe).

In the left pane, navigate to the
following key:
HKEY_LOCAL_MACHINE\
Software\Microsoft\Exchange\
ContentFilter.

Right-click on ContentFilter, select
New, and then DWORD Value.

Name the new value
CheckAuthSessions.

Right-click on the
CheckAuthSessions value and
select Modify.

6. Inthe Value Data field, enter 1. This
causes IMF to check all messages,
whether sent by anonymous or
authenticated users. If you want
to stop filtering mail sent by
authenticated users, change the
value data to 0.

For additional information on the

Exchange IMF, including updates to

the software, see http://technet.

microsoft.com/en-us/exchange/
bb288484.aspx. @
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Enhance site capabilities with server-side
scripting

N

One of the fun — and occasionally intimidating — things about web design is that there’s usually
more than one way to achieve a certain goal or create a specific effect. For example, you can save
your images as GIF or JPEG files, format your text with HTML tags or CSS style, and create hyperlinks
using either text or graphics. In each case, the choice you make presents specific advantages and
disadvantages. A tool that works great for one application may be nearly worthless for another.
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That’s why it's important that
your webmaster toolbox contain as

you'll discover, PHP is a powerful,
popular, and versatile tool.

many different tools as possible. Just

as a carpenter would never approach
a job with only a claw hammer, you

Pis for PHP

For reasons only a programmer

shouldn’t approach web projects with
just HTML code. We'll introduce you to
PHP, which lets you quickly add server-

could appreciate, PHP is a recursive
abbreviation, which stands for PHP:
Hypertext Preprocessor. Recursion aside,

side scripting to your web pages. As

IT Professional
Graphic/Design

eb Developer
ffice Worker
U

3
'?-'e-Tips

Sign-up

PHP is an easy-to-understand open-

Graphic & Design eTips to Enhance
Your Work

If you are an expert at what you do, then you
want to sign up for FREE New Horizons Graphics &
Digital Designer eTips. Each week you will receive
expert advice from our experienced editors that
will improve your productivity and enhance your
work. Learn more about the applications you use
everyday, including: Adobe lllustrator, Adobe
InDesign, Adobe Pagemaker, Adobe Photoshop,
Digital Photography and QuarkXPress. Imagine
the possibilities with the skills you'll gain!

source scripting language that's ideally
suited for use on the web. You can either
embed PHP scripting in HTML or save it
in an external file and call it from HTML,
much as you would with an external
JavaScript file.

Unlike JavaScript, which runs
on the client (user) machine, PHP is a
server-side language — hence the pre-
processor part of its name. PHP code
runs on the server before HTML is sent
to the browser, so you'll only see HTML
code if you view the source of a PHP
document in the browser.

The major implication of using
a server-side language is that the lan-
guage must be installed on the server.
Fortunately, most major server plat-
forms support PHP, and it's commonly
available with hosting packages from
Web presence providers. In fact, some
15 million domains were PHP-compli-
ant as of December 2003.

Related Courses
. PHP 5 Introduction

Since PHP runs on the server, not
the client machine, you don't have to
worry about which browser the user
has or whether he’s enabled JavaScript.
The page he sees will be pure HTML.

Here, for example, is the code
for an exceedingly simple page with
embedded PHP scripting. The embed-
ded PHP scripting is shown in blue:

<html>
<body>
<?php echo $_ENV["HTTP_HOST"]; ?>
</body>
</html>

As you can see, the PHP script — a single
echo statement in this case — appears
inside a special PHP tag.

This script echoes, or displays
onscreen, the current page’s HTTP
host — in other words, the site’s URL.
If you viewed the page’s source in the
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browser, you'd see something like this:
<html>

<body>

www.elijournals.com

</body>

</html>

Because the script is processed on the
server side, the PHP code never appears
in the browser.

Get up to speed on PHP: For extensive
information on PHP, including usage
figures and installation instructions,
visit The PHP Group’s website at www.
php.net.

Listing A:

PHP code to create an “add to favorites” link

Put PHP to work

Now that we've covered the basics of
PHP, let’s look at a simple application.
As you probably know, it's fairly easy
to create a hyperlink that, when a user
clicks on it, opens Internet Explorer’s
Add Favorite dialog box. Such a link
won't work in other browsers, however,
so webmasters often use JavaScript
to detect the browser in use and only
display the link in Internet Explorer.
PHP lets you do the same thing, and
the equivalent code is both simpler and
more elegant.

To see PHP in action, open a test
website in your web authoring applica-

Listing B:
PHP code for refer.php

tion, and create a new web page. Now,
switch to HTML/Code mode and add
the code from Listing A between the
<body>and </body> tags.

Now, save the page as favorites.
php — note the special extension.

Open the live version of your
page in your browser. (If you've been
working on a local copy of your site,
you'll need to publish it to the server
first.) If the browser you're using is
Internet Explorer, the page will look
like the one in Figure A; otherwise,
nothing should appear.

Look back at the code in Listing
A, and you'll see one of PHP’s most

<?

<?php
if (strpos($_SERVER["HTTP_USER_AGENT"], “MSIE")
l== false) {
if(!strpos($_SERVER["HTTP_USER_AGENT"], "Opera")
>0 ) {
7>

<span style="color:blue; cursor:hand;

mail("$recipient_email", "Site Recommendation", "Hi,

W $recipient_name!\r\n\r\n$sender_name at

@ $sender_email asked me to tell you about the site

W at $link.\r\n\r\nWebmaster\r\n$link",

"From: webmastere{$_ SERVER[ 'SERVER_NAME'I1}\r\n"
."Reply-To: webmastere{$_SERVER[ ‘SERVER_NAME'I}\r\n"
."X-Mailer: PHP/" . phpversion());

@ text-decoration:underline' onclick="window

W .external.AddFavorite(location.href,
W document.title); '>Bookmark This Page</span>

<?php
}
}

7>

echo "An email has been sent to $recipient_name at

W <a href=\"mailto:$recipient_email\">

W $recipient_email</a> from

W $sender_name at <a href=\"mailto:$sender_email\">

W) $sender_email</a> about the site <a href=$link>

W $link</a>.";

7>

versatile features: the ability to jump
from PHP to HTML and back, even in
the middle of a block of PHP code.

In our example, we start with two
nested if statements, which determine
whether the current browser is IE. If it
is, we then jump out of PHP to create
the Bookmark This Page link. Finally,
we return to PHP to close the control
structures.

A more robust PHP
example

The previous section offered a relatively
trivial example of how you can use PHP
in your sites. You won't be surprised to
learn that PHP has much more powerful
capabilities. In this section, we'll explain
how you can use PHP to create a “tell

a friend” form, one that lets visitors
recommend your site to their friends via
email.

2 New Page 5 - Microsoft Internet Explorer

File Edit ‘iew Favorites  Tools  Help
(;;) - - ij Lgi
Back. Skop Refresh
Boolmark This Page

The PHP code gives visitors a link
to bookmark your website to their
Favorites list.


www.php.net
www.php.net

Listing C:
Code to add to form.php

<?php $fullurl = "{$HTTP_HOST}";
$fullurl = "http://" . $fullurl;
echo "<input type=hidden name=Link

value=$fullurl>";?>

<A Recommend This Site - Microsoft Internet Explorer

File  Edit  ‘iew Favorites Tools  Help

N @B &

Stop Refresh Harme

S 74

Tell a friend about this site!

Tour MName
Tour Email
Tour Friend's Natme

Tour Friend's Email

Your new page includes a four-
field form and instructions.

To add the code to your webpage:

1. Create a new document in your
web authoring program.

2. Switch to HTML, Code, or Source
Code mode.

Delete the code you see there,
and replace it with the code from
Listing B.

4. Save thefile as refer.php.

Build the page

Next, create the page shown in Figure
B, which includes instructions and a
four-field form where site visitors can
refer friends to your site by using this
form. You may also want to add a note
explaining that the site doesn’t collect or
share the email addresses users enter.
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To refer to the fields in the PHP script
by giving them specific names:

To configure the form so its results
go to refer.php:

1. Select the first textbox field and 1.
access the Text Box Properties

Type refer.php in the Action text
box of your form handler.

Choose POST as the Method. Now,
all we have to dois add a little PHP
scripting to the page. Switch to
HTML, Code, or Source Code mode
and add the code from Listing C
just after the <form> tag.
This code creates a hidden form field,
link, and assigns as its value the current
site’s URL.

Next, save the form page as form.
php and load its live version in the
browser. Complete the form, putting

dialog box or Inspector. 2.

Type sender_name in the Name
text box (click OK if you're using a
dialog box).

3. Continue in the same manner,
name the second field sender_
email, the third recipient_name,
and the fourth recipient_email.

Connect the form to the script
Like all forms, the one we've just created
is configured to send its results to a file.
However, we want to send the results to
refer.php instead.

yourself down as both sender and recipi-
ent, and click Submit. You'll see a mes-
sage in the browser indicating that your
recommendation has been sent. @
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